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Abstract—These instructions give you guidelines for preparing 

reports for Physics 372. Use this document as a template if you 
are using Microsoft Word 6.0 or later. Otherwise, use this 
document as an instruction set. Define all symbols used in the 
abstract. Do not cite references in the abstract. Do not delete the 
blank line immediately above the abstract; it sets the footnote at 
the bottom of this column. 
 

Index Terms—About four key words or phrases in 
alphabetical order, separated by commas.  Use your imagination. 
 

I. INTRODUCTION 
HIS document is a template for Microsoft Word versions 
6.0 or later. If you are reading a paper version of this 

document, please download the electronic file, P372-
Report.doc from http://www.phys.uregina.ca/phys372 so you 
can use it to prepare your manuscript. If you would prefer to 
use LATEX, download the LATEX style and sample files 
from the same Web page. Use these LATEX files for 
formatting, but please follow the instructions in P372-
Report.doc or P372-Report.pdf. 

When you download and open P372-Report.doc, select 
“Page Layout” from the “View” menu in the menu bar (View | 
Page Layout), which allows you to see the footnotes. Then 
type over sections of P372-Report.doc or cut and paste from 
another document and then use markup styles. The pull-down 
style menu is at the left of the Formatting Toolbar at the top of 
your Word window (for example, the style at this point in the 
document is “Text”). Highlight a section that you want to 
designate with a certain style, and then select the appropriate 
name on the style menu. The style will adjust your fonts and 
line spacing. Do not change the font sizes or line spacing to 
squeeze more text into a limited number of pages. Use 
italics for emphasis; do not underline.  

To insert images in Word, position the cursor at the 
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insertion point and either use Insert | Picture | From File or 
copy the image to the Windows clipboard and then Edit | Paste 
Special | Picture (with “Float over text” unchecked).  

Please preserve the formatting in this template. Please 
observe the page limits (maximum six pages) as explained 
in class.  

 

II. PROCEDURE FOR REPORT SUBMISSION 

A. Preparation Stage 
You will need to submit your report by hard copy and 

electronically for review. For the hard copy, submit one copy 
such that only one column appears per page. This will give 
your instructors plenty of room to write comments. Submit a 
second copy in two-column format electronically (by email to 
zisis@uregina.ca), so that the overall formatting and layout 
can be graded. 

For the one-column format, please do the following: 
 --First, click on the View menu and choose Print Layout. 
 --Second, place your cursor in the first paragraph. Go to 

the Format menu, choose Columns, choose one column 
Layout, and choose “apply to whole document” from the 
dropdown menu. 

 --Third, click and drag the right margin bar to just over 4 
inches in width. 
The graphics will stay in the “second” column, but you can 
drag them to the first column. Make the graphic wider to push 
out any text that may try to fill in next to the graphic. 

B. Submission Stage 
When you are ready to submit your final version, after your 

instructor has approved the contents of your lab book, print 
one copy in one-column format, including figures and tables, 
as described above. 

You must also submit your two-column final report by 
email, in both Word and PDF format to the above email 
address. 

C. Figures 
All tables and figures will be processed as images in your 

report. However, if this was a journal paper, you would have 
been asked to submit enlarged versions of the tables and 
figures separately as the journal cannot extract those 
embedded in your document. (In that case, the figures and 
tables you insert in your document are only to help you gauge 
the size of your paper, for the convenience of the referees, and 
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to make it easy for you to distribute preprints.) This is not a 
concern for Physics 372. 

D. Electronic Image Files (Optional) 
You will have the greatest control over the appearance of 

your figures if you are able to prepare electronic image files. If 
you do not have the required computer skills, just submit 
paper prints as described above and skip this section. 

1) Easiest Way: If you have a scanner, the best and quickest 
way to prepare noncolor figure files is to print your tables and 
figures on paper exactly as you want them to appear, scan 
them, and then save them to a file in PostScript (PS) or 
Encapsulated PostScript (EPS) formats. Use a separate file for 
each image. File names should be of the form “fig1.ps” or 
“fig2.eps.” 

2) Slightly Harder Way: Using a scanner as above, save the 
images in TIFF, JPEG or GIF format. High-contrast line 
figures and tables should be prepared with 600 dpi resolution 
and saved with no compression, 1 bit per pixel (monochrome), 
with file names of the form “fig3.tif” or “table1.tif.” To obtain 
a 3.45-in figure (one-column width) at 600 dpi, the figure 
requires a horizontal size of 2070 pixels. Typical file sizes will 
be on the order of 0.5 MB. 

Photographs and grayscale figures should be prepared with 
220 dpi resolution and saved with no compression, 8 bits per 
pixel (grayscale). To obtain a 3.45-in figure (one-column 
width) at 220 dpi, the figure should have a horizontal size of 
759 pixels.  

Color figures should be prepared with 400 dpi resolution 
and saved with no compression, 8 bits per pixel (palette or 256 
color). To obtain a 3.45-in figure (one column width) at 400 
dpi, the figure should have a horizontal size of 1380 pixels. 

The above numbers are to be used only as broad 
guidelines.  However, please ensure that the size of your 
report on disk is not significantly larger than 1 MB.  Consult 
your instructor if you exceed this limit BEFORE submitting 
your report by email or hardcopy. 

3) Other Ways: Experienced computer users can either 

create or convert figures and tables from their original format 
to TIFF, JPEG or GIF. Please consult the information sheets 
posted in LB129 and LB131 for an application suitable to your 
needs. 

 The information in the next four paragraphs is not 
required for Physics 372.  The instructions below are 
general for your knowledge and future use.  They may not 
be applicable to all versions of Microsoft products. 

Here is a way to make TIFF image files of tables, if you so 
desire.  First, create your table in Word. Use horizontal lines 
but no vertical lines. Hide gridlines (Table | Hide Gridlines). 
Spell check the table to remove any red underlines that 
indicate spelling errors. Adjust magnification (View | Zoom) 
such that you can view the entire table at maximum area when 
you select View | Full Screen. Move the cursor so that it is out 
of the way. Press “Print Screen” on your keyboard; this copies 
the screen image to the Windows clipboard. Open Microsoft 
Photo Editor and click Edit | Paste as New Image. Crop the 
table image (click Select button; select the part you want, then 
Image | Crop). Adjust the properties of the image (File | 
Properties) to monochrome (1 bit) and 600 pixels per inch. 
Resize the image (Image | Resize) to a width of 3.45 inches. 
Save the file (File | Save As) in TIFF with no compression 
(click “More” button).  

Most graphing programs allow you to save graphs in TIFF; 
however, you often have no control over compression or 
number of bits per pixel. You should open these image files in 
a program such as Microsoft Photo Editor and re-save them 
using no compression, either 1 or 8 bits, and either 600 or 220 
dpi resolution (File | Properties; Image | Resize). See Section 
II-D2 for an explanation of number of bits and resolution. If 
your graphing program cannot export to TIFF, you can use the 
same technique described for tables in the previous paragraph. 

A way to convert a figure from Windows Metafile (WMF) 
to TIFF is to paste it into Microsoft PowerPoint, save it in JPG 
format, open it with Microsoft Photo Editor or similar 
converter, and re-save it as TIFF. 

Microsoft Excel allows you to save spreadsheet charts in 
Graphics Interchange Format (GIF). To get good resolution, 
make the Excel charts very large. Then use the “Save as  
HTML” feature). You can then convert from GIF to TIFF 
using Microsoft Photo Editor, for example. No matter how 
you convert your images, it is a good idea to print the TIFF 
files to make sure nothing was lost in the conversion.  

Since you will be using this template for all reports in 
Physics 372, you should save it as “P372-
ExperimentName-AuthorName.doc or .pdf.  For 
experiment name please use “Circuits”, “Kater”, 
“Cavendish”, “Speed”, “Millikan”, and “Rutherford”.  
For author name please use your last name and first 
initial; e.g. “P372-Cavendish-SmithA.doc”. 

 
Fig. 1.  Magnetization as a function of applied field. Note that “Fig.” is 
abbreviated. There is a period after the figure number, followed by two 
spaces. It is good practice to explain the significance of the figure in the 
caption. 
  



> First A. Author, Physics 372, U of Regina, Cavendish Experiment (DOUBLE-CLICK HERE TO EDIT YOUR INFO) < 
 

3 

E. Copyright Form 
A Journal copyright form would accompany your final 

submission, if this were a journal paper. You can get a .pdf, 
.html, or .doc version from the web pages of the journal or 
from the first issues in each volume of the journal. Authors are 
responsible for obtaining any security clearances. 

 

III. MATH 
If you are using Word, use either the Microsoft Equation 

Editor or the MathType add-on (http://www.mathtype.com) 
for equations in your paper (Insert | Object | Create New | 
Microsoft Equation or MathType Equation). “Float over text” 
should not be selected.  

 

IV. UNITS 
Use either SI (MKS) or CGS as primary units. (SI units are 

strongly encouraged.) English units may be used as secondary 
units (in parentheses). This applies to papers in data 
storage. For example, write “15 Gb/cm2 (100 Gb/in2).” An 
exception is when English units are used as identifiers in trade, 
such as “3½ in disk drive.” Avoid combining SI and CGS 
units, such as current in amperes and magnetic field in 
oersteds. This often leads to confusion because equations do 
not balance dimensionally. If you must use mixed units, 
clearly state the units for each quantity in an equation. 

The SI unit for magnetic field strength H is A/m. However, 
if you wish to use units of T, either refer to magnetic flux 
density B or magnetic field strength symbolized as µ0H. Use 
the center dot to separate compound units, e.g., “A·m2.” 

 

V. HELPFUL HINTS 

A. Figures and Tables 
Position figures and tables appropriately throughout the 

text.  This means that figures and tables should be near and 
following their reference in the text. Large figures and tables 
may span both columns. Place figure captions below the 
figures; place table titles above the tables. If your figure has 
two parts, include the labels “(a)” and “(b)” as part of the 
artwork. Please verify that the figures and tables you mention 
in the text actually exist. Please do not include captions as 
part of the figures. Do not put captions in “text boxes” 
linked to the figures. Do not put borders around the 
outside of your figures. Use the abbreviation “Fig.” even at 
the beginning of a sentence. Do not abbreviate “Table.” Tables 
are numbered with Roman numerals.  

Color printing of figures is allowed. However, do not use 
color unless it is necessary for the proper interpretation of 
your figures. 

Figure axis labels are often a source of confusion. Use 
words rather than symbols. As an example, write the quantity 
“Magnetization,” or “Magnetization M,” not just “M.” Put 
units in parentheses. Do not label axes only with units. As in 

Fig. 1, for example, write “Magnetization (A/m)” or 
“Magnetization (A !m−1),” not just “A/m.” Do not label axes 
with a ratio of quantities and units. For example, write 
“Temperature (K),” not “Temperature/K.”  

Multipliers can be especially confusing. Write 
“Magnetization (kA/m)” or “Magnetization (103 A/m).” Do 
not write “Magnetization (A/m) × 1000” because the reader 
would not know whether the top axis label in Fig. 1 meant 
16000 A/m or 0.016 A/m. Figure labels should be legible, 
approximately 8 to 12 point type. 

B. References 
Number citations consecutively in square brackets [1]. The 

sentence punctuation follows the brackets [2]. Multiple 
references [2], [3] are each numbered with separate brackets 
[1]–[3]. When citing a section in a book, please give the 
relevant page numbers [2]. In sentences, refer simply to the 
reference number, as in [3]. Do not use “Ref. [3]” or 
“reference [3]” except at the beginning of a sentence: 
“Reference [3] shows ... .” Do not use automatic endnotes in 
Word; type the reference list at the end of the paper using the 
“References” style. 

Number footnotes separately in superscripts (Insert | 
Footnote).1 Place the actual footnote at the bottom of the 
column in which it is cited; do not put footnotes in the 
reference list (endnotes). Use letters for table footnotes (see 
Table I).  

 
1It is recommended that footnotes be avoided (except for the unnumbered 

footnote with the receipt date on the first page). Instead, try to integrate the 
footnote information into the text. 

TABLE I 
UNITS FOR MAGNETIC PROPERTIES 

Symbol Quantity Conversion from Gaussian and 
CGS EMU to SI a 

Φ magnetic flux 1 Mx → 10−8 Wb = 10−8 V·s 
B magnetic flux density,  

  magnetic induction 
1 G → 10−4 T = 10−4 Wb/m2 

H magnetic field strength 1 Oe → 103/(4π) A/m 
m magnetic moment 1 erg/G = 1 emu  

  → 10−3 A·m2 = 10−3 J/T 
M magnetization 1 erg/(G·cm3) = 1 emu/cm3 

  → 103 A/m 
4πM magnetization 1 G → 103/(4π) A/m 
σ specific magnetization 1 erg/(G·g) = 1 emu/g → 1 A·m2/kg 
j magnetic dipole  

  moment 
1 erg/G = 1 emu  
  → 4π × 10−10 Wb·m 

J magnetic polarization 1 erg/(G·cm3) = 1 emu/cm3 
  → 4π × 10−4 T 

χ, κ susceptibility 1 → 4π 
χρ mass susceptibility 1 cm3/g → 4π × 10−3 m3/kg 
µ permeability 1 → 4π × 10−7 H/m  

  = 4π × 10−7 Wb/(A·m) 
µr relative permeability µ → µr 
w, W energy density 1 erg/cm3 → 10−1 J/m3 

N, D demagnetizing factor 1 → 1/(4π) 

No vertical lines in table. Statements that serve as captions for the entire 
table do not need footnote letters.  

aGaussian units are the same as cgs emu for magnetostatics; Mx = 
maxwell, G = gauss, Oe = oersted; Wb = weber, V = volt, s = second, T = 
tesla, m = meter, A = ampere, J = joule, kg = kilogram, H = henry. 
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Please note that the references at the end of this document 
are in the preferred referencing style. Give all authors’ names; 
do not use “et al.” unless there are six authors or more. Use a 
space after authors' initials. Papers that have not been 
published should be cited as “unpublished” [4]. Papers that 
have been submitted for publication should be cited as 
“submitted for publication” [5]. Papers that have been 
accepted for publication, but not yet specified for an issue 
should be cited as “to be published” [6]. Please give 
affiliations and addresses for private communications [7]. 

Capitalize only the first word in a paper title, except for 
proper nouns and element symbols. For papers published in 
translation journals, please give the English citation first, 
followed by the original foreign-language citation [8]. 

C. Abbreviations and Acronyms 
Define abbreviations and acronyms the first time they are 

used in the text, even after they have already been defined in 
the abstract. Commonly used abbreviations such as APS, PRL, 
ac, and dc do not have to be defined. Abbreviations that 
incorporate periods should not have spaces: write “C.N.R.S.,” 
not “C. N. R. S.” Do not use abbreviations in the title unless 
they are unavoidable. 

D. Equations 
Number equations consecutively with equation numbers in 

parentheses flush with the right margin, as in (1). First use the 
equation editor to create the equation. Then select the 
“Equation” markup style. Press the tab key and write the 
equation number in parentheses. To make your equations more 
compact, you may use the solidus ( / ), the exp function, or 
appropriate exponents. Use parentheses to avoid ambiguities 
in denominators. Punctuate equations when they are part of a 
sentence, as in 
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Be sure that the symbols in your equation have been defined 

before the equation appears or immediately following. 
Italicize symbols (T might refer to temperature, but T is the 
unit tesla). Refer to “(1),” not “Eq. (1)” or “equation (1),” 
except at the beginning of a sentence: “Equation (1) is ... .” 

E. Other Recommendations 
Use one space after periods and colons. Hyphenate complex 

modifiers: “zero-field-cooled magnetization.” Avoid dangling 
participles, such as, “Using (1), the potential was calculated.” 
[It is not clear who or what used (1).] Write instead, “The 
potential was calculated by using (1),” or “Using (1), we 
calculated the potential.” 

Use a zero before decimal points: “0.25,” not “.25.” Use 
“cm3,” not “cc.” Indicate sample dimensions as “0.1 cm × 0.2 
cm,” not “0.1 × 0.2 cm2.” The abbreviation for “seconds” is 
“s,” not “sec.” Do not mix complete spellings and 
abbreviations of units: use “Wb/m2” or “webers per square 

meter,” not “webers/m2.” When expressing a range of values, 
write “7 to 9” or “7-9,” not “7~9.” 

A parenthetical statement at the end of a sentence is 
punctuated outside of the closing parenthesis (like this). (A 
parenthetical sentence is punctuated within the parentheses.) 
In American English, periods and commas are within 
quotation marks, like “this period.” Other punctuation is 
“outside”! Avoid contractions; for example, write “do not” 
instead of “don’t.” The serial comma is preferred: “A, B, and 
C” instead of “A, B and C.” 

If you wish, you may write in the first person singular or 
plural and use the active voice (“I observed that ...” or “We 
observed that ...” instead of “It was observed that ...”). Use the 
chosen voice consistently throughout the document. 
Remember to check spelling. If your native language is not 
English, please get a native English-speaking colleague to 
proofread your paper.  

 

VI. SOME COMMON MISTAKES 
The word “data” is plural, not singular. The subscript for 

the permeability of vacuum µ0 is zero, not a lowercase letter 
“o.” Use the word “micrometer” instead of “micron.” A graph 
within a graph is an “inset,” not an “insert.” The word 
“alternatively” is preferred to the word “alternately” (unless 
you really mean something that alternates). Use the word 
“whereas” instead of “while” (unless you are referring to 
simultaneous events). Do not use the word “essentially” to 
mean “approximately” or “effectively.” Do not use the word 
“issue” as a euphemism for “problem.”  

Be aware of the different meanings of the homophones 
“affect” (usually a verb) and “effect” (usually a noun), 
“complement” and “compliment,” “discreet” and “discrete,” 
“principal” (e.g., “principal investigator”) and “principle” 
(e.g., “principle of measurement”). Do not confuse “imply” 
and “infer.”  

Prefixes such as “non,” “sub,” “micro,” “multi,” and 
“"ultra” are not independent words; they should be joined to 
the words they modify, usually without a hyphen. There is no 
period after the “et” in the Latin abbreviation “et al.” (it is also 
italicized). The abbreviation “i.e.,” means “that is,” and the 
abbreviation “e.g.,” means “for example” (these abbreviations 
are not italicized). 

An excellent style manual and source of information for 
science writers is [9]. Additional information may be obtained 
from the general Physics style guides on Manuscript 
Submission, is available at http://authors.aps.org/tips.html or at 
http://www.elsevier.com/wps/find/journaldescription.cws_ho
me/505705/authorinstructions.  
 

VII. EDITORIAL POLICY 
The information in the next three paragraphs is for your 

own knowledge and not applicable to your reports for 
Physics 372.  

Submission of a manuscript is not required for participation 
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in a conference. Do not submit a reworked version of a paper 
you have submitted or published elsewhere. Do not publish 
“preliminary” data or results. The submitting author is 
responsible for obtaining agreement of all coauthors and any 
consent required from sponsors before submitting a paper. It is 
the obligation of the authors to cite relevant prior work. 

Many JOURNALS do not publish conference records or 
proceedings. Some JOURNALS do publish papers related to 
conferences that have been recommended for publication on 
the basis of peer review. As a matter of convenience and 
service to the technical community, these topical papers may 
be collected and published in one issue of the journal. 

At least two reviews are required for every paper submitted. 
For conference-related papers, the decision to accept or reject 
a paper is made by the conference editors and publications 
committee; the recommendations of the referees are advisory 
only. Undecipherable English is a valid reason for 
rejection. Authors of rejected papers may revise and resubmit 
them to the JOURNAL as regular papers, whereupon they will 
be reviewed by two new referees. 

 

VIII. PUBLICATION PRINCIPLES 
The contents of practically all JOURNALS are peer-reviewed 

and archival. Each JOURNAL publishes scholarly articles of 
archival value as well as tutorial expositions and critical 
reviews of classical subjects and topics of current interest.  

Authors should consider the following points: 
1) Technical papers submitted for publication must advance 

the state of knowledge and must cite relevant prior work.  
2) The length of a submitted paper should be commensurate 

with the importance, or appropriate to the complexity, of 
the work. For example, an obvious extension of 
previously published work might not be appropriate for 
publication or might be adequately treated in just a few 
pages. 

3) Authors must convince both peer reviewers and the 
editors of the scientific and technical merit of a paper; the 
standards of proof are higher when extraordinary or 
unexpected results are reported.  

4) Because replication is required for scientific progress, 
papers submitted for publication must provide sufficient 
information to allow readers to perform similar 
experiments or calculations and use the reported results. 
Although not everything need be disclosed, a paper must 
contain new, useable, and fully described information. For 
example, a specimen's chemical composition need not be 
reported if the main purpose of a paper is to introduce a 
new measurement technique. Authors should expect to be 
challenged by reviewers if the results are not supported by 
adequate data and critical details. 

5) Papers that describe ongoing work or announce the latest 
technical achievement, which are suitable for presentation 
at a professional conference, may not be appropriate for 
publication in a TRANSACTIONS or JOURNAL. 

 

IX. CONCLUSION 
A brief conclusion section is required. Although a 

conclusion may review the main points of the paper, do not 
replicate the abstract as the conclusion. A conclusion might 
elaborate on the importance of the work or suggest 
applications and extensions.  

APPENDIX 
Appendixes, if needed, appear before the acknowledgment. 

ACKNOWLEDGMENT 
The preferred spelling of the word “acknowledgment” in 

American English is without an “e” after the “g.” Use the 
singular heading even if you have many acknowledgments. 
Avoid expressions such as “One of us (S.B.A.) would like to 
thank ... .” Instead, write “F. A. Author thanks ... .” I wish to 
thank Drs. P. Bergbusch and Z. Papandreou for their 
assistance and advice. 
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